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1. Introduction 
This manual should give you all the information required to install and operate your new 
light source. 

Additional information can be found on our website at www.coolled.com. 

2. Safety Precautions 
While LEDs are a much safer illumination system than the mercury and metal halide lamps 

that they replace in microscopy applications, precautions should still be taken with this 

product. 

When operating or maintaining this product, please observe the following safety precautions 

at all times. Failure to do so may result in personal injury or damage to other items. 

Please ensure that only the power supply and cord supplied are used with this equipment. 

The AC cord supplied with this Light Source must only be used with the equipment supplied. 

2.1.  
UV light may be emitted from this product depending on the version/wavelength selected. 
Avoid eye and skin exposure. Never look directly into the light output beam from the Light 
Source or accessories. The emissions could damage the cornea and retina of the eye if the 
light is observed directly. 

2.2.  
Always ensure that the Light Source is securely attached to the microscope (either directly or 
with a liquid light guide and collimator, depending on the version) prior to turning on the 
power. This will minimise the risk of injury and damage. 

2.3.  
If for any reason the Light Source is to be operated when not attached to a microscope, all 
personnel should wear eye shielding and clothing to protect the exposed skin. 

2.4.  
Disconnecting the mains supply is achieved by unplugging the power cord from the power 
supply block or the Light Source. Only plug in the power cable, once the Light Source is 
attached to the microscope. 

http://www.coolled.com/
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2.5.  
There are no serviceable parts within the Light Source. Removing any of the screws and 
covers will result in the safety of the Light Source being impaired. The DC power supply unit 
should be inspected periodically throughout the lifetime of the system. 

2.6.  
Any electronic equipment connected to this product must comply with the requirements 
EN/IEC 60950. 

2.7.  
To clean the exterior of the Light Source, use a slightly dampened cloth with a simple 
water/detergent solution only. Avoid the optical surfaces and lenses. Cleaning of optics 
should only be carried out using optical wipes and fluids. Please note that the DC power 
supply unit should be isolated prior to cleaning. 

2.8.  
This product conforms to the requirements of the Safety Standards as follows: 

EN/IEC 61010-1:2010 Safety requirements for Electrical Equipment for Measurement, 
Control and Laboratory use. 

EN62471:2008 Photo-biological Safety of Lamps and Lamp Systems/ Guidance on 
manufacturing requirements relating to non-laser optical 
radiation safety. Risk Group 3. 

2.9. EMC compliance 
This product is tested to the requirements of standard IEC/EN 61326-1 concerning 
electromagnetic compatibility. This is a Class A product. In a domestic environment 
this product may cause radio interference in which case the user may be required to 
take adequate measures. 

All warnings may not be applicable depending on the version/wavelength being used. 
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3. Getting Started – System Components 
A CoolLED pE-800 Series Illumination System is supplied with the following components: 

• Main Light Source with Optical Output for 3 mm liquid light guide. 

• DC Power Supply type GST160A12-R7B. 

• IEC Power Cable. 

• USB Cable. 

• User Guide (USB stick). 

• A variety of Hex keys. 

• 340 nm & 380 nm excitation filters (pE-800fura only) 

In addition to the components listed above, it is possible that a liquid light guide, collimator 
or additional accessories will be supplied. 

When un-packing the system, it is important to check the contents against the delivery note. 

If any components are missing or appear damaged, please contact CoolLED or the reseller 
who supplied the equipment immediately. 
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4. Installation and Setup 

4.1.  
Carefully unpack the components from the shipping material. 

4.2.  
Insert the liquid light guide into the light output port of the Light Source. Ensure that the end 
of the liquid light guide is fully inserted and gently tighten the grub screw to retain it in 
position. 

4.3.  
Ensure that there is free airflow around the Light Source so that the cooling system is not 
impaired. A gap of 100 mm around the light source is sufficient. For optimal cooling 
performance the Light Source should only be operated in the orientation shown throughout 
this document, stood on its four rubber feet. 
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4.4.  
Connect the second end of the liquid light guide into the desired microscope using the 
required coupling mechanism. If using the pE-Universal Collimator, refer to the User Manual 
for correct installation, which is available on our website: 
www.coolled.com/products/accessories/pe-universal-collimator/. 
If using the pE-UV Universal Collimator, please visit: 
http://www.coolled.com/products/accessories/pe-uv-universal-collimator/. 

4.5.   
With the liquid light guide fitted between the Light Source and the microscope, it is now safe 
to connect the mains power. Insert the power connector from the DC power supply as 
shown, with the flat of the connector body facing up. 

https://www.coolled.com/products/accessories/pe-universal-collimator/
http://www.coolled.com/products/accessories/pe-uv-universal-collimator/
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4.6.  
Connect the mains lead supplied to a convenient socket, plug the IEC connector into the DC 
power supply and switch the power on at the mains. The pE-800 Series Light Source can now 
be switched on using the rocker switch shown in the below image. 
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5. pE-800 Series LEDs overview 

5.1. pE-800 

5.1.1.  
The pE-800 is an eight-channel Illumination System, with each of the eight channels covering 
a distinct spectral region to suit use with common fluorophores and their relevant filter sets, 
from DAPI in the UV to Cy7 in the near infra-red. Each channel is individually controllable, 
allowing only the required LEDs to be illuminated and the irradiance of these to be adjusted 
to provide the desired signal. 

5.1.2. Variants 
In order to deliver the best performance with the wide range of available filter sets, it is 
necessary to have two variants of the pE-800. 
The “SB” variant which has an LED peaking at 365 nm in the UV region and the “MB” variant 
which has an LED peaking at 400 nm in the Violet region allow for optimal excitation of DAPI. 
All other installed LEDs remain the same across the two variants. 
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5.2. pE-800fura 

5.2.1.  
The pE-800fura is an eight-channel Illumination System, built for scientists monitoring calcium 
and pH or using optogenetics alongside everyday fluorescence, and spans 340-635 nm 
(covering Fura-2 to Cy5). Each channel is individually controllable, allowing only the required 
LEDs to be illuminated and the irradiance of these to be adjusted to provide the desired 
signal. 
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6. Control Overview 

6.1. Communication requirements 
To communicate with the pE-800 Series a connection needs to be made between the PC and 
Light Source. A USB A-male to B-male cable will have been provided with the System. 
Connect the USB A connector into a free port on the PC and connect the USB B connector 
into the USB socket on the Light Source side panel (next to the power input). Please note the 
correct orientation of this connector, with the top-side of the cable housing facing up.  
The interface is a ‘virtual COM port’ style and a setup procedure may be necessary to enable 
communication between a PC and the Light Source. See Appendix 1 for more details. 

6.2. CoolLED LightBridge 
To allow control of the pE-800 Series, CoolLED has developed a graphical user interface 
called the LightBridge. 
The LightBridge software can be downloaded either from the User Guide (USB stick) that is 
provided with the pE-800 Series or from the CoolLED website 
(www.coolled.com/support/imaging-software/#coolled-lightbridge). 

https://www.coolled.com/support/imaging-software/#coolled-lightbridge
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Details of the operation of the LightBridge can be found in the relevant section of this User 
Manual. 
Communication with the LightBridge is achieved through a USB connection. 

6.3. Third party Imaging Software 
The pE-800 Series can be operated under a range of popular imaging software packages. 
Details of specific packages can be found on the CoolLED website 
(www.coolled.com/support/imaging-software/). 

6.4. TTL 
The pE-800 Series can be controlled directly by TTL signals to control the ON/OFF state of 
the Light Source. To define the LED irradiance or to set a sequence, the TTL signals will need 
to be applied in combination with communication from the LightBridge application. 
Breakout cables are available to connect to TTL signal-generating hardware. See Breakout 
cables for details. 
Details of the voltage requirements and the switching performance are shown in the graph 
below. 

< 7 µs < 3 µs 

https://www.coolled.com/support/imaging-software/
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6.4.1. pE-800 
The details of the physical TTL connections for the pE-800 are shown below. 

 
TTL Port 
15 Position D-Sub, High Density Receptacle, Female Sockets Connector 

Pin # Name Type Maximum Rate Input/Output 
Voltages 

1 635 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
2 550 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
3 470 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
4 TTL OUT 2 Digital Output 0 ≤ Vout ≤ 3.3 V (typ) 

0.4 (max) ≤ Vout ≤ 2.9 V(min) 

5 GLOBAL TTL Digital Input 0 ≤ V in ≤ 5.5 V 
6 GROUND Power - 
7 GROUND Power - 
8 GROUND Power - 
9 TTL OUT 1 Digital Output 0 ≤ Vout ≤ 3.3 V (typ) 

0.4(max) ≤ Vout ≤ 2.9 V(min) 

10 GROUND Power - 
11 500 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
12 435 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
13 365 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
14 740 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
15 580 nm Digital Input 0 ≤ Vin ≤ 5.5 V 

Global Input 
BNC Connector Jack, Female Socket 50Ω 
Pin 

# 
Name Type Maximum Rate Input/Output 

Voltages 
1 GLOBAL TTL Digital Input 0 ≤ Vin ≤ 5.5 V 
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6.4.2. pE-800fura 
The details of the physical TTL connections for the pE-800fura are shown below. 

TTL Port 
15 Position D-Sub, High Density Receptacle, Female Sockets Connector 

Pin # Name Type Maximum Rate Input/Output 
Voltages 

1 435 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
2 340 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
3 580 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
4 TTL OUT 2 Digital Output 0 ≤ Vout ≤ 3.3 V (typ) 

0.4 (max) ≤ Vout ≤ 2.9 V(min) 

5 GLOBAL TTL Digital Input 0 ≤ V in ≤ 5.5 V 
6 GROUND Power - 
7 GROUND Power - 
8 GROUND Power - 
9 TTL OUT 1 Digital Output 0 ≤ Vout ≤ 3.3 V (typ) 

0.4(max) ≤ Vout ≤ 2.9 V(min) 

10 GROUND Power - 
11 635 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
12 550 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
13 500 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
14 470 nm Digital Input 0 ≤ Vin ≤ 5.5 V 
15 380 nm Digital Input 0 ≤ Vin ≤ 5.5 V 

Global Input 
BNC Connector Jack, Female Socket 50Ω 
Pin 

# 
Name Type Maximum Rate Input/Output 

Voltages 
1 GLOBAL TTL Digital Input 0 ≤ Vin ≤ 5.5 V 
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6.5. Analogue 
The irradiance of the LEDs in the pE-800 Series can be set by applying an Analogue Voltage 
to the relevant connections. A signal of 0-10 V can be applied to the Analogue inputs and 
relates to 0-100 % irradiance. For example, a 6.5 V signal applied to an input will set the 
channel to 65 % irradiance. 
Breakout cables are available to connect to analogue signal-generating hardware. See 
Breakout cables for details. 

6.5.1. pE-800 
The details of the physical Analogue connections for the pE-800 are shown below. 

Analogue Port 
15 Position D-Sub, High Density Receptacle, Female Sockets Connector 
Pin # Name Type Maximum Rate Input/Output Voltages 

1 635 nm Analogue Input 0 ≤ Vin ≤ 10 V 
2 550 nm Analogue Input 0 ≤ Vin ≤ 10 V 
3 470 nm Analogue Input 0 ≤ Vin ≤ 10 V 
4 ANALOGUE OUT 2 Analogue Output 0 ≤ Vout ≤ 10 V 
5 INTERLOCK Digital Input 0 ≤ Vin ≤ 5.5 V 
6 ANALOGUE 

GROUND 
Power - 

7 ANALOGUE 
GROUND 

Power - 

8 ANALOGUE 
GROUND 

Power - 

9 ANALOGUE OUT 1 Analogue Output 0 ≤ Vout ≤ 10 V 
10 GROUND Power - 
11 500 nm Analogue Input 0 ≤ Vin ≤ 10 V 
12 435 nm Analogue Input 0 ≤ Vin ≤ 10 V 
13 365 nm Analogue Input 0 ≤ Vin ≤ 10 V 
14 740 nm Analogue Input 0 ≤ Vin ≤ 10 V 
15 580 nm Analogue Input 0 ≤ Vin ≤ 10 V 
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6.5.2. pE-800fura 
The details of the physical Analogue connections for the pE-800 are shown below. 

Analogue Port 
15 Position D-Sub, High Density Receptacle, Female Sockets Connector 
Pin # Name Type Maximum Rate Input/Output Voltages 

1 435 nm Analogue Input 0 ≤ Vin ≤ 10 V 
2 340 nm Analogue Input 0 ≤ Vin ≤ 10 V 
3 580 nm Analogue Input 0 ≤ Vin ≤ 10 V 
4 ANALOGUE OUT 2 Analogue Output 0 ≤ Vout ≤ 10 V 
5 INTERLOCK Digital Input 0 ≤ Vin ≤ 5.5 V 
6 ANALOGUE 

GROUND 
Power - 

7 ANALOGUE 
GROUND 

Power - 

8 ANALOGUE 
GROUND 

Power - 

9 ANALOGUE OUT 1 Analogue Output 0 ≤ Vout ≤ 10 V 
10 GROUND Power - 
11 635 nm Analogue Input 0 ≤ Vin ≤ 10 V 
12 550 nm Analogue Input 0 ≤ Vin ≤ 10 V 
13 500 nm Analogue Input 0 ≤ Vin ≤ 10 V 
14 470 nm Analogue Input 0 ≤ Vin ≤ 10 V 
15 380 nm Analogue Input 0 ≤ Vin ≤ 10 V 
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7. LightBridge – Standard/TTL mode 

7.1.  
When the CoolLED LightBridge is opened the below display will be shown (if the Light Source 
is not switched on). The status will be shown in the bottom right corner as Offline. 

7.2.  
Once the power switch of the Light Source is turned on and the System is connected to the 
PC with a USB cable, the LightBridge will detect the presence of the Light Source and show 
the status as “Online”. At this point the installed LEDs listed at the top of the display will be 
updated to reflect whether an SB or MB version of the pE-800, or a pE-800fura is being used. 
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7.3.  
The irradiance of each of the eight channels can be adjusted by either clicking and moving 
the slider with your mouse, typing the irradiance figure in the text box or adjusting the 
irradiance using the arrows. 

7.4.  
Checking the box below the irradiance figure will put that channel into a selected state. 
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7.5.  
Pressing the On/Off button in the bottom left corner of the display will cause all wavelengths 
in the selected state to illuminate at their defined irradiance. 
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8. LightBridge – Analogue Mode 
Analogue Mode allows the irradiance level of the pE-800 or pE-800fura to be controlled from 
a voltage signal to the relevant Analogue input pin on the Light Source. 

8.1.  
Click on the ‘Analogue Mode’ check box whilst in the ‘Standard/TTL’ mode of operation in 
LightBridge to access Analogue Mode. 

8.2.  
The channel selection, channel irradiance, and On/Off status controls are unavailable in 
Analogue Mode. These parameters are now controlled by the input signals. 
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8.3.  
Selecting only the ‘Analogue Mode’ allows the channel irradiance to be defined by a signal to 
the relevant Analogue input. All channels are automatically set to the ON state. Applying an 
Analogue input signal to an Analogue connection will cause the channel to illuminate at the 
defined irradiance level. 

8.4.  
Selecting ‘TTL Enabled’ and ‘Analogue Mode’ allows the channel irradiance to be defined by 
a signal to the relevant Analogue input. 
The On/Off state of the Light Source is controllable with a TTL signal. 
A signal to the global TTL pin causes all channels with an Analogue signal applied to 
illuminate with a TTL high. 
A signal to the dedicated channel TTL inputs causes the dedicated channel to illuminate if an 
Analogue signal is applied to the corresponding channel that also has a TTL high applied. 
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9. LightBridge – Sequence Runner Mode 

9.1.  
To access Sequence Runner Mode click on the dropdown tab at the top of the page that is 
labelled “Standard/TTL” under normal operating conditions. Select “Sequence” from the 
dropdown list. 

9.2.  
Once “Sequence Runner Mode” is selected the following display will be shown. All channels 
will be set to the off state at 0 % irradiance. 
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9.3.  

Define the triggering order by checking the boxes of the required channels in the order you 
would like them to illuminate. The first box checked will select the first channel of a 
triggering sequence, the second box will select the second channel and so on. This will be 
shown by a number appearing next to the check box to show this order. The irradiance will 
also need to be set using either the slider, arrows or text boxes for each required channel. 

9.4.  
To activate the sequence, click the “Ready” button. 
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9.5.  
“Sequence is running” will be displayed to show that the sequence is active. 

The pE-800 Series Illumination System will now trigger the defined channels in the order 
selected with every TTL high signal to the “Global TTL” input. 

The order of triggering is now fixed until the sequence is stopped, but the irradiance level of 
channels can still be adjusted. 

1st channel 
of sequence 

2nd channel 
of sequence 

3rd channel 
of sequence 

4th channel 
of sequence 
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9.6.  
To stop the sequence, click the “Stop” button. 

9.7.  
If you wish to change the defined triggering order, press the “Clear” button. 
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9.8.  
All the checkboxes will now be reset and list “0” next to all channels. 

10. LightBridge – Demo Mode 

10.1.  
The CoolLED LightBridge includes a Demo mode, which allows some of the features and a 
level of automation to be demonstrated without the need for additional hardware or 
software. 

10.2.  
To access “Demo Mode” click on the dropdown tab at the top of the page that is labelled 
“Standard/TTL” under normal operating conditions. Select “Demo” from the dropdown list. 
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10.3.  
Once “Demo Mode” is selected the following display will be shown. All channels will be set 
to the off state at 0 % irradiance. 

10.4.  
Set the required channel irradiance levels by adjusting the relevant slider, typing in the text 
box or using the arrows. Define the selected channels by clicking in the designated check 
box. The order in which these are selected will be the order in which they illuminate. This 
will be indicated by a number appearing next to the box. 

Channel and 
order selection 

Channel 
irradiance 
selection 
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10.5.  
Select whether you would like the light output to be a pulse or to ramp up by checking the 
box for one of these fields. 

10.6.  
Define the pulsing interval or ramp duration by typing in the text box or using the arrows. 
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10.7.  
To start the demonstration sequence, press the “OFF” button to change the state to “ON”. 

10.8.  
Whilst the sequence is running the selected channels, order of triggering and interval cannot 
be adjusted. 
To stop the sequence, press the “ON” button to change the state to “OFF”. 



 

DOC-058 Iss 7  30 
 

10.9.  
To change the channels that will be triggered or adjust the order, the clear button will need 
to be pressed. 

10.10.  
All channels will have their sequence order returned to “0”. The other settings will remain. 
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11. LightBridge – Additional settings 

11.1. Power Up Configurator 
The Power Up Configurator allows you to determine the mode of operation, channel 
intensities and selected state that the pE-800 Series Illumination System will default to when 
powered up connected to the LightBridge. 

11.1.1.  
The Power Up Configurator can be accessed from the “Tools” drop-down menu at the top of 
the page. 

11.1.2.  
The below window will be displayed showing the available channels and information. 
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11.1.3.  
The channel irradiance levels can be adjusted by either typing into the text box or using the 
arrow buttons. The selected state of each of the channels can also be set using the relevant 
check boxes. 

11.1.4.  
Alternatively, the pE-800 Series Illumination System can be set to initialise in “Analogue 
Mode” by selecting the “Analogue enable” option from the dropdown menu. The channel 
selection and irradiance levels will be unavailable, as these will be defined by the Analogue 
signals applied to the pE-800. 

Channel irradiance 
selection 

Channel 
selected state 
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11.1.5.  
For the chosen settings to be selected upon power-up, the “Irradiance level set, LEDs on” or 
“Irradiance level set, LEDs off” option needs to be selected from the dropdown menu. 

11.1.6.  
To confirm the settings, press the “Save & Exit” button. Alternatively, if you do not wish to 
confirm the settings press the “Exit” button. Both options will return you to the mode that 
you were in before entering the Power Up Configurator. 
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11.2. System information 
Information about the pE-800 Series Illumination System can be accessed using the 
LightBridge. 

11.2.1.  
To access the system information, please select the ‘About’ option from the ‘File’ dropdown 
menu. 

11.2.2.  
The following window will be displayed. 
The ‘Software version’ refers to the version of LightBridge that is being operated. 
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11.3. LightBridge display settings 

11.3.1.  
The LightBridge application window can be increased or decreased in size by using the ‘+’ or 
‘-‘ buttons at the top of the window. 

11.3.2.  
To ensure that the Lightbridge application is always accessible when using multiple 
applications, it is possible to set the LightBridge to always appear in front of other windows. 
To access this setting select the ‘Window always on top’ option from the ‘Tools’ dropdown 
menu. 
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11.4. Saving and loading settings 

11.4.1.  
It is possible to save the current settings in the LightBridge to be recalled later. With the 
desired settings in place, select the “Save as” option from the “File” dropdown menu. 

11.4.2.  
A window similar to the below example shall be displayed. Choose the location to save, 
name the file and press the “Save” button. 
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11.4.3.  
The saved settings will be confirmed at the bottom of the LightBridge window. 

11.4.4.  
To load previously saved settings, select the “Load mode from file” option from the “File” 
dropdown menu. 
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11.4.5.  
Select the desired preset file from your saved location and press the “Open” button. 

11.4.6.  
The loaded settings will be shown on the LightBridge window. 
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11.5. Exiting the LightBridge 
When pressing the “X” button in the top-right hand corner of the LightBridge to exit the 
application, you will be presented with a dropdown menu. 

Pressing the “Exit – pE-800 LEDs shut down” option in the example below will close the 
LightBridge and change the state of the Light Source to OFF. 

Pressing the “Exit – pE-800 LEDs on with last settings” option will close the LightBridge but 
maintain the current state of all channels. This may be required if continuing to control the 
Light Source externally (for example via TTL). 
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12. Fitting Excitation Filters 

12.1.  
An Excitation Filter Holder is provided with all pE-800 Series Illumination Systems as 
standard. This will arrive installed into the Light Source. 

12.2.  
The Excitation Filter Holder can be removed from the pE-800 Series Light Source by 
loosening the two thumbscrews. 



 

DOC-058 Iss 7  41 
 

12.3.  
The Excitation Filter Holder has eight positions (one for each channel) to accept standard 25 
mm excitation filters. 

12.3.1. pE-800  
The image below shows the corresponding position for each of the channels in the pE-800. 
The SB version is installed with a 365 nm LED and the MB version is installed with a 400 nm 
LED. 

A label is fitted to the top side of the Excitation Filter Holder that indicates which position 
corresponds to each of the LEDs optical paths. 

Filter position: Corresponding LED 

740 nm 500 nm 
635 nm 470 nm 
580 nm 435 nm 
550 nm 365 nm 

(This side faces LED Light sources) 

An example of the label fitted to an Excitation 
Filter Holder for an SB variant pE-800. 

365 nm or 400 nm 
435 nm 

470 nm 
500 nm 

550 nm 
580 nm 

635 nm 
740 nm 
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12.3.2. pE-800fura  
The image below shows the corresponding position for each of the channels 

in the pE-800fura. 

 

A label is fitted to the top side of the Excitation Filter Holder that indicates which position 
corresponds to each of the LEDs optical paths. 

12.4.  
The Excitation Filter Holder has been designed so that it is only possible to fit into the Light 
Source in one orientation. 

Profile shape of the Excitation Filter Holder 

Filter position: Corresponding LED 

470 nm 635 nm 
435 nm 580 nm 
380 nm 550 nm 
340 nm 500 nm 

(This side faces LED Light sources) 

An example of the label fitted to an Excitation 
Filter Holder for an SB variant pE-800. 

500 nm 
550 nm 

580 nm 
635 nm 

340 nm 
380 nm 

435 nm 
470 nm 
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12.5.  
To ensure the optimal performance of installed excitation filters, it is important that these 
are fitted in the correct orientation. The arrow in the below image shows the direction of 
light through the pE-800 Series Light Source. 

Most excitation filters have a directional arrow on the side. Excitation filters should be 
installed in the holder with this arrow pointing down (as shown in the image below). 

Excitation filter 



 

DOC-058 Iss 7  44 
 

12.6.  
The excitation filters are secured into the holder with a single grubscrew per filter. A suitable 
hex key will be provided with the pE-800 Series Illumination System. 

12.7.  
The Excitation Filter Holder should be fully inserted into its channel and secured in position 
using the two thumbscrews. Take care not to over-tighten these. 

Grubscrew locations 
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13. Excitation Filter Specifications (pE-800fura only) 
The pE-800fura Illumination System is supplied with two excitation filters for use with the 340 
nm and 380 nm channels for Fura-2 ratiometric calcium imaging. 

13.1. Specification 
The 340 nm excitation filter is marked as ‘BP340/20’. The transmission is centred around 340 
nm. 
The 380 nm excitation filter is marked as ‘BP380/20’. The transmission is centred around 380 
nm. 
These are to be fitted in the relevant positions in the Excitation Filter Holder. 
Further information for fitting the excitation filters can be found in the Fitting Excitation 
Filters section of this User Manual. 



 

DOC-058 Iss 7  46 
 

 

13.2. Transmission spectrum 
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14. Breakout cables 
CoolLED Breakout cables for the pE-800 and pE-800fura (ordered separately) are used for 
TTL/analogue control. Breakout cables are available with BNC or SMB connectors for 
compatibility with a wide range of third-party hardware components. 
Further details can be found on the CoolLED website 
(www.coolled.com/products/accessories/breakout-cables/). 

14.1.  
Connect the 15-position male connector to the 15-position female TTL or analogue 
connector on the pE-800 or pE-800fura Light Source. 

https://www.coolled.com/products/accessories/breakout-cables/
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14.2.  
Secure the cable in position by tightening the screws on the connector. 

14.3.  
Connect the BNC or SMB connectors to the available TTL or analogue signal-generating 
hardware. 

BNC connectors SMB connectors 
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14.3.1. pE-800 
The table below identifies the label that corresponds to the LED (or LEDs) of 

the pE-800 Light Source. Note that they are numbered 1-8 in wavelength 

order (from UV to NIR) for ease of use. 

Breakout cables for pE-800 

 Part code: pE-CABLE-9WBNC or pE-CABLE-9WSMB 

 

Cable label Corresponding pE-800 LED 

1 UV (365 nm or 400 nm) 

2 435 nm 

3 470 nm 

4 500 nm 

5 550 nm 

6 580 nm 

7 635 nm 

8 740 nm 

Gbl Global (for TTL control only) 
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14.3.2. pE-800fura 
The table below identifies the label that corresponds to the LED (or LEDs) of 

the pE-800fura Light Source. Note that they are numbered 1-8 in wavelength 

order (from UV to NIR) for ease of use. 

Breakout cables for pE-800fura 

 Part code: pE-CABLE-9WBNC-FR or pE-CABLE-9WSMB-FR 

 

Cable label Corresponding pE-800fura LED 

1 340 nm 

2 380 nm 

3 435 nm 

4 470 nm 

5 500 nm 

6 550 nm 

7 580 nm 

8 635 nm 

Gbl Global (for TTL control only) 

15. Software updates 

15.1.  
Occasionally it may be necessary to upgrade the firmware of the Light Source. This can be 
carried out in the field by following the steps below. Please contact support@coolled.com 
for the necessary firmware file. 

mailto:support@coolled.com
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15.2.  
To upgrade the Light Source firmware using the LightBridge, the System needs to be put into 
Firmware update mode. Starting with the Light Source switched off, press and hold the 
firmware upgrade button whilst turning the Light Source on using the rocker switch. The 
firmware upgrade button is located through the small hole in the case above the indicator 
LED, at a depth of roughly 10 mm. A thin, non-metallic instrument will be required to reach 
this button. 

15.3.  
An indicator LED shall be illuminated from the firmware upgrade button to show that boot 
loader mode has been selected and the green power indicator LED will not be illuminated. 

15.4.  
When a firmware upgrade is carried out for the first time you may need to direct the PC to 
the Bootloader driver. This can be confirmed by opening Device Manager in Windows. 
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If the Bootloader driver needs to be added the System will be displayed under ‘Other 
devices’ with a yellow exclamation mark symbol. 

If the System is correctly recognised in Device Manager under ‘Ports COM & LPT)’ at this 
stage proceed to section 15.10. 

15.5.  
Right click on the ‘STM32 BOOTLOADER’ and select ‘Update Driver’. 

15.6.  
Select ‘Browse my computer for drivers’. 
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15.7.  
Select ‘Browse…’ to locate the Bootloader driver location. 

15.8.  
The driver will be located within the LightBridge folder that has been installed to your 
computer. 
Locate the folder and select the ‘CoolLED Bootloader Driver’ file. 
Click ‘OK’ to confirm. 
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15.9.  
The Bootloader driver will be updated, and a confirmation window will be shown. 

15.10.  
When the LightBridge is opened the window below will be shown. Click on the box labelled 
“…” and select the required firmware file from the saved location on your PC. 
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15.11.  
Once the file has been selected, the file path length will populate the “File” box. To load the 
firmware file to the Light Source, press the “Start Flashing” button. 

15.12.  
Once the firmware programming has been completed a message will display “Programming 
complete”. Pressing the “Exit” button will return you to the default workbench page. 
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15.13.  
The Light Source shall remain in Firmware Update mode, as indicated at the bottom of the 
LightBridge window, until the power is cycled using the rocker switch. 

15.14.  
The new firmware version can be confirmed by following the steps in LightBridge – 
Additional settings section. 
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16. Additional information 

16.1. Grounding pin 
For particularly sensitive applications, such as Electrophysiology, it may be desirable ground 
the pE-800 Series Light Source to avoid any electrical interference. The pE-800 Series Light 
Source has a designated location to allow for a grounding pin to be attached. This is located 
on the right-hand side of the Light Source and has an internal M3 thread for connection. 
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17. Product Specifications 

17.1. Power Requirements 
110-240V AC 50/60 Hz  2.0 A 

17.2. Power Consumption 

Eight wavelengths operating Max 135 W 

17.3. Dimensions 

pE-800 Series Light Source 261 mm (w) x 174 mm (d) x 174 mm (h) 
-weight 3.51 kg 

Power Supply 175 mm (w) x 72 mm (d) x 35 mm (h) 
-weight 0.58 kg 

17.4. Environmental Conditions 
The pE-800 Series Illumination System is designed for indoor use only. 
Operating Altitude: ≤ 3,000 m asl 
Working Temperature: 5 ~ 35 °C 
Working Humidity: 20 % ~ 90 % RH non-condensing 
Storage Temp. & Humidity: -40 ~ +85°C, 10 ~ 95 % RH 
Input Voltage Range:  85 ~ 264 VAC 
Input Frequency Range: 47 ~ 63 Hz 
Pollution Degree 2 - Normally only nonconductive pollution occurs.  
Temporary conductivity caused by condensation is to be expected. 

18. Product Options and Order Codes 
See website (www.coolled.com/products/) for full details of product options and order 
codes. 

https://www.coolled.com/products/
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19. Warranty and Repairs 
Please refer to CoolLED’s current Warranty Policy available on our website 
www.coolled.com/support/coolled-warranty/. Although warranty terms are fixed at the 
time of ordering according to the terms and conditions of sale in place, the Warranty Policy 
may be subject to periodic change so please check to avoid confusion. 

For any warranty queries or in the event of the product developing a fault, make contact 
with support@coolled.com for further assistance. You shall be asked to provide your 
microscope make and model, the product serial number and a brief description of the issue. 
You shall then be issued with a Support Case to manage your issue. 

20. Compliance and Environmental 
For current compliance statements and environmental information please refer to our 
website www.coolled.com/support/environment/. 

20.1. CoolLED’s Recycling Program 

At CoolLED, we recognise the importance of preserving the global environment. We are 
proud to provide a Recycling Program that enables CoolLED customers and end-users to 
send back used CoolLED Light Sources for recycling, free of charge. 

Together we can reduce the burden on our environment through responsible disposal 
and recycling of end-of-life Light Sources. You can help us by filling in our online contact 
form and providing us with your contact details and the serial number of the CoolLED 
Light Source that you wish to return, and we will collect it free of charge. 

If you are taking delivery of a replacement CoolLED Light Source, why not arrange to 
send the old one back in the packaging box of the new one? 
 

https://www.coolled.com/support/coolled-warranty/
mailto:support@coolled.com
https://www.coolled.com/support/environment/
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21. Contact Details 

21.1. Headquarters Address 
CoolLED Ltd 
26 Focus Way 
Andover 
Hampshire 
SP10 5NY 
UK 

21.2. Telephone 
Worldwide -  +44 (0)1264 323040 
USA & Canada -  1-800-877-0128 

21.3. Fax 
Worldwide -  +44 (0)1264 723897 

21.4. Email 
General -  info@coolled.com 

21.5. Website      www.coolled.com 

mailto:info@coolled.com
http://www.coolled.com/
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22. Appendix 1 

Installing your CoolLED system on Windows machines 

22.1. Windows 10 
When you first plug your CoolLED system into your PC with the USB cable, Windows will 
automatically install the driver files. 

22.2. Windows 8 and earlier 
The first time your CoolLED Illumination System is connected to your PC via USB you shall 
need to follow the steps below to allow a virtual COM port to be assigned. 

22.2.1.  
The CoolLED pE Driver needs to be downloaded from the CoolLED website. This file can be 
found on the following page: www.coolled.com/support/imaging-software/ 

Once downloaded this needs to be saved somewhere on your PC. 

22.2.2.  
Navigate to the ‘Device manager’. 
The CoolLED Illumination System should initially be listed under ‘Other devices’ as ‘USB 
Virtual Serial Port’ with a yellow exclamation mark icon. 
Right-click on this and select the ‘Update Driver Software…’ option from the list. 

https://www.coolled.com/support/imaging-software/
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22.2.3.  
The window shown below will be displayed. Select the ‘Browse my computer for driver 
software’ option. 

22.2.4.  
Select the ‘Let me pick from a list of device drivers on my computer’. 
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22.2.5.  
Select ‘Port (COM & LPT)’ and then click the ‘Next’ button. 

22.2.6.  
Select the ‘(Standard port types)’ from the ‘Manufacturer’ field, select ‘Communications 
Port’ from the ‘Model’ field and press the ‘Have Disk…’ button. 
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22.2.7.  
Press the ‘Browse…’ button on the ‘Install From Disk’ window.  

Locate the CoolLED pE Driver file and press the ‘Open’ button. 



 

DOC-058 Iss 7  65 
 

The ‘Copy manufacturer’s files from:’ field will now be populated with the server location of 
the pE-Driver. Press ‘OK’ to confirm this. 
 

22.2.8.  
Select ‘CoolLED USB Virtual Serial Port A’ in the ‘Model’ field and press ‘Next’. 

 

22.2.9.  
A warning window will be displayed. Press the ‘Yes’ button to confirm 
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22.2.10.  
A Windows security page may be displayed at this stage. Press the check box labelled 
‘Always trust software from “CoolLED Ltd”’ and press the ‘Install’ button. 
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22.2.11.  
A window will be displayed confirming that the driver software has been updated. Press the 
‘Close’ button. The pE-800 Series Illumination System will now be ready to use via USB. 

 

22.2.12  
With the pE-800 Series Illumination System now recognised by Windows, the specific Virtual 
COM port that has been assigned can be found in ‘Device Manager’ by expanding the ‘Ports 
(COM & LPT)’ field. The pE-800 Series Illumination System will be listed as ‘CoolLED USB 
Virtual Serial Port A’. 


